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NAFTEN 3

Jolid Modling - Uktriade Optiony

Basic Solid Modeling
Extrude Options

- Upon successful completion of this lesson, you will be able to:
* Sketch on planes and/or planar surfaces.
* Use the sketch tools to construct geometry.
* Add the geometric relations or constraints.
* Add/modify dimensions.
* Explore the different extrude options.
- The following 5 basic steps will be demonstrated throughout this exercise:

* Select the sketch plane.

* Activate Sketch pencil t .

* Sketch the profile using the sketch tools :/: @ R .

* Define the profile with dimensions e\ or relations h :

* Extrude the profile ol .

- Be sure to review the self-test questionnaires at the end of the lesson, prior
to moving to the next chapter.
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Basic Solid Modeling
Extrude Options

View Orientation Hot Keys:

Ctrl + 1 = Front View

Ctrl + 2 = Back View

Ctrl + 3 = Left View

Ctrl + 4 = Right View

Ctrl + 5 =Top View

Ctrl + 6 = Bottom View

Ctrl + 7 = Isometric View

Ctrl + 8 = Normal To
Selection

Dimensioning Standards: ANSI
Units: INCHES — 3 Decimals

Relations

2t

Add Geometric e\

Tools Needed:

C Insert Sketch ./:

Trim Entities

Line @ Circle
Dimension _\| Sketch Fillet
iﬂ Boss / Base
Extrude
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1. Starting a new Part:

- From the File menu, select New / Part, or click the New icon.

-
Part Assembly Drawing
a 3D representation of a single design a 3D arrangement of parts and/or other a 2D engineering drawing, typically of a
ssemblies part or assembly
5] [Gwm] [rm

- Select the Part template from either the Templates or Tutorial folders.

- Click OK [__8&_|; a new part template is opened.

JD’SSOLIDWORKS‘ File Edit View Insert Tools Window Help G‘ O-BF-EB-82-5 ' ® & - Part1.SLOPRT B searcnmiesanamogels Q-] ? v o O X
& | S-G@- N e [l Mirror Entities 78 Move Entities ~
2 l 3 I ~
Sketen  Smart = Display/Delete = | Quick
i Offset [ Dynamic Mirrar Entities F~ Split Entities Repair Rapid  Modify
Dimension tities %€t [F] Dy o Relations Bl | Snaps | Rapid  Modily

(RN O) |- © B B EE Unearsketen pattern  + ] sketch Picture

Features | Sketch | Evaluate LPLLPBB-D-R-¢&- -0 .:.@‘22‘

o
@[E[E[e]S
\'é
€@ Part1 (Default<<Defautt>_Displa
» [&) Annotations
Solid Bodies
Surface Bodies
@} Material <not specified>
[} Front
(] Top
[ Right

1. origin

il ENER

Lo

v

A

< >| *1sometric
Model [ 30 Views | Motion Study 1] ]
SOLIDWORKS Premium 2016 x54 Edition Editing Part Ps_ - @

3-3



SOLIDWORKS 2016 | Basic Tools | Basic Solid Modeling — Extrude Options

2. Changing the Scene:

- From the View (Heads-up) toolbar, click the Apply Scene button (arrow) and
select the Plain White option (arrow).

- By changing the scene color to Plain White we can better see the colors of the
sketch entities and their dimensions.

J,y:wuawom\ Fie Bt view et Toots window wep @ OB -@-8-0-[5]]0 B@- [ D seornfiesandmodes Q-] 7+ = O X
S-@-N - nes - f
Sketth  smart
‘‘‘‘‘‘‘‘ g0
o e@-0 N
Features | Sketch [ Evaluste PHAPB- T 03 D ECIEES
S [E[R[e]E
< Plain White
@, Pat! (Defauit<<Default> Displa
es Rooftop
[@) surface Bodies T E e
@ Material <not specified>
5 Urban 5 Background
[} Front
e Backdrop - Ambient White
1l Top
11 Right Backdrop - Black with FillLights
L, oigin Manage Favorites
]
1
ZA‘A
< >| *1somefric
Model [ 30 Views | 17 1
| Apply Scene Editing Part IPS.

C @ / 2 g
- To show the i O
. . . LB | Skﬂ;" PERPS B R -O&-T-

Origin, click
the View pemen
dropdown (%;‘;:i::;
menu and st

. . 0 oo
select Origins.

- The Blue
Origin is the
Zero position
of the part
and the Red
Origin is the
Zero position
of a sketch.

Blue Origin

Part!

< >| Isometric
[ Model [ 30 Views

- 00in ¥: 000in Z: 000in

Editing Part
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3. Starting a new Sketch:

- Select the Front plane
from the Feature-
Manager tree and
click the Pencil icon

i2E
sketen| tQ Start a new

sketch.

- A sketch is normally
created first, relations
and dimensions are
added after, and then
it gets extruded into ===

< >
| IR Model [ 30 Views | Motion Stdy 1|
= i or

'''''''''

=]
=)
0

L)

imeETes

a 3D feature.

2
- From the Command- |_ DS SOLIDWORKS

File Edit View Insert Tools

Window Help 59 D - B

Manager toolbar, fes

Exit

select the Line Sketch

& EHo-wv-o

Smart

# ©
Trim Convert

Dimension | [ ~ wo . @ T _Z%. Entities Entities ©
. @@ e .y

[PH] Mirror Entities

ffset Dynamic Mirror Entities
Entities E’m

EE Linear Sketch Pattern

:/: Features | Sketch | Evaluate |
command.

OPTION:

Mouse Gesture.)

Mouse Gesture

- Hover the mouse cursor
over the Origin point; a
yellow feedback symbol
appears to indicate a
relation (Coincident)
is going to be added
automatically to the 1
endpoint of the line. This
endpoint will be locked
at the zero position.

_FromT Plaine

CommandManager

Right-Drag to display the Mouse Gesture guide and select the Line command
from it. (See the Introduction section, page XVIII for details on customizing the

Vi

Auto-Relation
feedback symbol
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4. Using the Click + Hold + Drag technique:

- Click at the Origin point and hold the mouse button to start the line at
point 1, drag upwards to point 2, then release the mouse button.

2

and drag to Point 2

Front Plane

—t

Start the line from Point 1

0" The Base Sketch

The Base Sketch is the
parent sketch of a part and
is also the very first sketch
in a part document. It
should primarily describe
the basic shape of the part
before other features can
be added.

- Continue adding other lines using the Click-Hold-Drag technique.

- The relations like Horizontal and Vertical are added automatically to each
sketch line. Other relations like Collinear and Equal are added manually.

- The size and shape of the profile will be corrected in the next few steps.

3-6
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System Feedback
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5. Adding Geometric Relations*:

- Click Add Relation J:I. under Display/Delete Relations - OR - select Tools /
Relations / Add.

Puman - [ L 1C (B @ o " Select the 4 lines shown below.

Display/Delete ic
Split Entities Repair Rapid Modify
- Relations | cpaten | M5 Sketen  Sketch

- Bd] sketch Picture

— - Click Equal from the Add Geometric Relation dialog

5] j:ﬁ G.;: @ J@ Display/Delete Relpfions . .
‘ - | box. This relation makes the length of the two selected
[T Fully Define Sketch

lines equal.

* Geometric relations are one of the most powerful features in SOLIDWORKS.
They’re used in the sketch level to control the behaviors of the sketch entities when
they are moved or rotated and to keep the associations between one another.

When applying geometric relations between entities, one of them should be a 2D
entity and the other can either be a 2D sketch entity or a model edge, a plane, an
axis, or a curve, etc.

Add Relations s
i, : Horizontal
% Equal Relations Geometric relations can be created || vetica
manually or automatically. The é collinear

Adding the EQUAL next few steps in this chapter will = Z:r::le'<:-
relations to these lines demonstrate how geometric ? .
eliminates the need to relations are added manually. —
dimension each line. Omlog For comstruction -

Select the top 4 lines and
click Equal relation.

The top 4 lines are
now Equal in size.
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6. Adding a Collinear relation**:

- Select the Add Relation J:I- command again.
- Select the 3 lines as shown below.

- Click Collinear from the Add Geometric Relations dialog box.

- Click OK '¥).
Select the bottom 3 lines and
click Collinear relation
Add Relations ~
: Harizontal
| | vertical
- i Collinear
‘Q\ Parallel
= | Equal
| Fix
Options Fad
|:| For construction

The bottom 3 lines are
moved to the same level.

_Q; Collinear Relations

Adding a Collinear
relation to these lines
puts them on the same
height level; only one
dimension is needed to
drive the height of all 3
lines.

** Collinear relations can be used to constrain the geometry as follows:
- Collinear between a line and another line(s) (2D and 2D).

- Collinear between a line(s) to a linear edge of a model (2D and 3D).
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Geometric Relations Examples

Coincident
P4 /

An endpoint is
Coincident with a line.

Midpoint
7 /

An endpoint is
Coincident with a
midpoint of a line.

Tangent

+ An arc is tangent with

a line or another arc.

Two circles are
sharing the same
center.

Concentric

Equal

Tangent

Two lines are on the same level
(or Co-planar).

Two circles or two lines
having the same size.

' y
oniM

Vertical

Two or more
points are
aligned vertically.

Horizontal

3-9
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7. Adding the horizontal dimensions:

- Select *f? from the Sketch toolbar - OR - select Insert / Dimension, and add
the dimensions shown below (follow the 3 steps A, B and C).

J/%SOL'DWORKS‘ File Edit View Insert Tools Windo

Gl & | AGQ V-1 & @ g
Exit Smart Trim Convert
Sketch | Dimension * A | entities Entities  Offsel
e e ® -oe| . o

L
Features ‘ S Smart Di

 —|
ion (D)

Creates a dimension for one or more

== | selected entities.
@ et

A. Click line 1

B. Click line 2

Modify
X 8 24 :7(F
D1@Sketchl

0.500in =
gl

C. Place the dimension 50
approximately here,
type .500 and press
enter.

- The Inch-Units is filled in
automatically because it has
been set previously to Inches,
3 decimal places.

- Continue adding the
horizontal dimensions
as shown here.

SO0
NOTE: = 2.000 —=
The color of the sketch lines changes 4.000
from Blue to Black, to indicate that ’
they have been constrained with 6.500

dimensions.
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8. Adding the Vertical dimensions:

- With the Smart- ]
Dimension tool —
still selected, click

on line 1 and line 2;

place the dimension | Line 2 v ox @ 2 5|
apprOXImately as a . D1@Sketch

shown, and change Line 1 '

the value to .500 in. /|

500
A. Click line 1
— 2.000 —
4000 B. Click line 2
&.500
- Continue adding
other dimensions 4.500
until the entire 3500
sketch turns into
the Black color. T 2.300
| 1500
50|
500
— 2000 =
4000 ———
&.500

The Status of a Sketch:

The current status of a sketch is displayed in the lower right corner of the screen.

Fully Defined =  Black [Fully Defined |
Under Defined = Blue [Under Defined
Over Defined = Red | Over Defined
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M— Sketch Relation Symbols

B3
| |
| |
= /
EE
| |
E2
L 4.500
| | m
= 3.500
m | |
]
2.500
| |
m 1.500
A S A 2] *
| | E | | 50
| |
x f
500
2.000
4.000
4,500

e i e 9| 0--@-2-2-1 9. Hiding the Sketch Relation Symbols:

B3 Redaw

Screen Capture

Display
Modify

Lights and Cameras

CirleR Swept Cut ® B dro & w
» | Lofted Cut Fillet pl';"t:;;. &) oraft (d e . . .
T Y - The Sketch Relation Symbols indicates
: sRewm which geometric relation a sketch entity

Hide / Show » Hide All Types

Toolbars
Workspace
User Interface

H Fulscreen

Customize Menu

Abc
D All Annotations
Ay Pes

‘@ Temporary Axes

2, Coordinate Systems
%, Datum Reference Frame

=

has, but they get quite busy as shown.

- To hide or show the Sketch Relation
Symbols, go to the View menu and
Click off the Sketch Relations option.

Annotation Link Errors
Annotation Link Variables

] pecats
# Grid

Sketch Relation Symbols at a Glance

B8 Horizontal relation | Vertical relation

B Equal relation B Coincident relation

Ly, Sketch Relations

Hide / Show Bodies...

Customize Menu

i i/ Showimary s 2 Bl Tangent relation B Collinear relation
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10. Extruding the Base:

- The Extrude Boss/Base command is used to define the characteristic of a
3D linear feature.

E?SSOUDINDRKS File Edit View

@
- Click ==+ from the Features toolbar OR & 9 o Swept Boss/Base
select Insert / Boss Base / Extrude. :»Emm Revolved il Lofted Boss/Base

Boss/Base | Boss/Base

@ Boundary Boss/Base

I T T T
Extruded Boss/Base (E)
Extrudes a sketch or selected sketch
contours in one or two directions to
create a solid feature.

\ L_
£.500
S| E[R[&] e
@) Boss-Extrude 4
v x 6 - Set the following:
[sketeh Plane v] - Direction: Blind.

’m:;mn:d ] - Depth: 6.00 in.
I:

& [so00m - Enabled Reverse direction.
=y EI _ .
[] Draft outward - Clle OK z) .
[ pirection 2 ~
[J Thin Feature v
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11. Sketching on a Planar Face:

- Select the face as indicated.

=
- Click ™| or select Insert/Sketch and press the shortcut keys Ctrl+7 to

change to the Isometric view.

- Select the Circle command @ from the Sketch Tools toolbar.

Select the

Sketch Face _19\‘: Planar Surfaces

- A planar surface of the
model can also be used as
a Sketch Plane.

- The Sketch will then be
extruded normal to the
selected surface.

- Position the mouse cursor near
the center of the selected face,
and click and drag outward to
draw a circle.

- While sketching the circle,
the system displays the radius
value next to the mouse cursor.

- Dimensions are added after the
profile is created.

3-14
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- Select the Smart Dimension 2,008

Modify
& D1@Sketch2
command pried and add a 2.000 z
diameter dimension to the A EL
circle.
(Click on the circle and move
the mouse cursor outward at
approximately 45 degrees, and
place the dimension).
~

- To add the location dimensions
click the edge of the circle and
the edge of the model, place
the dimension, then correct
the value.

- Continue adding the location
dimensions as shown to fully
define the sketch.

- Select the Line command d/
and sketch the 3 lines as shown
below. Snap to the hidden edge 2250
of the model when it lights up.

- The color of the sketch should
change to black at this point (Fully
Defined).

3.000 3.000
$2.000 ®2.000

_— Auto-Snap to

Snap to

quadr. hidden edges

poin
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12. Using the Trim Entities command:

- Select the Trim Entities command

from the Sketch toolbar (arrow).

J[?’SSOLIDWORKS| File Edit View Insert Tools Window Help @

E {‘ / - Gj -\ - 5] a @ [Fll“] Mirror Entities

Exit Smart TIrim  |Convert

sketch | Dimension | LT * %% = (&) + A\ | entities | entities il ) oynamic Mirror
@-@ - o oKX . EE vinear sketch pi

[ —
Features | § Smart Di ion (D)

== | selected entities.
G [ s

|
Creates a dimension for one or more H

- Click the Trim to Closest option (arrow). When the pointer is hovered over
the entities, this trim command highlights the entities prior to trimming to
the next intersection.

{@%Trim Entities

Use this command
to trim, extend or
delete a sketch
entity.

SIEIR[&[E
ﬁTrim Ed

Select an entity to trim to the
nearest intersecting entity or to
drag to an entity

Options ~

i I: Power trim

4-0- Corner

o i
= Trim away inside

-

I¥1

= Trim away outside

- Hover the pointer over the lower portion of the circle, the portion that is going
to be trimmed-off lights up. Click the mouse button to trim.

- The bottom portion of the circle

is trimmed, leaving the sketch
as one-continuous-closed-
profile, suitable to extrude

into a feature.

- Next, we are going to look
at some of the extrude options
available in SOLIDWORKS.

3.000

2.000

/T

3.000

$2.000

.250

T
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13. Extruding a Boss:

- Switch to the Feature toolbar and click ﬁj] or select:
Insert / Boss-Base / Extrude.

’:QE Extrude Options...

Explore each extrude option to
see the different results.

Press Undo to go back to the
original state after each one.

@ Using the Blind option:

- When extruding with the
Blind option, the
following conditions
are required:

* Direction

* Depth dimension

‘p?SSOL;DWORxs‘ File Edit Wiew Inset Tools Window Help Q D 'E

ﬁ @ @ Swept Boss/Base

Extruded | Revolved J]', Lofted Boss/Base
Boss/Base| Boss/Base

@ oW [[f swept cut

Extruded Hl‘]‘|E Revolved LJU Lofted Cut

Cut Wizard Cut

@'VI Boundary Cut

@

Fille

55 "_I Boundary Boss/Base
-:,\V Features| Sketch ‘ Evaluaie‘

@ Elk ¢ &
7

@ Part1 (Default<<Default>_Displa

G B[E[e]e

@] Boss-Extrude 7

v x G

From A

Sketch Plane W

Direction 1 ~
o I

N T—

[¥] Merge result

-

Draft outward

[ pirection 2 ~

[ Thin Feature ~

Direction & Depth

Selected Contours v

- Drag the direction arrow on the preview graphics
to define the direction, then enter a dimension

for the extrude depth.

Using the Through All

option:

- When the Through All
option is selected, the
system automatically
extrudes the sketch to the
length of the part, normal
to the sketch plane.

REREE —

@) Boss-Extrude ¥l
v x 6f

From ~

Sketch Plane L4

Blind
Condition

Direction 1 ~
-
d I

Merge result

Draft outward 1

[ pirection 2 ~

[ Thin Feature ~

Selected Contours ~

3-17
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@ Using the Up To Next

option:

- With the Up To Next

option selected, the system

extrudes the sketch to
the very next set of
surface(s), and blends it
to match.

@ Using the Up To Vertex

option:

- This option extrudes
the sketch from its plane
to a vertex, specified by

the user, to define its depth.

@ Using the Up To
Surface option:

- This option extrudes the
sketch from its plane to a
single surface, to define
its depth.

Jllﬁﬁbe

]| Boss-Extrude

v x &

From ~

Sketch Plane v

Direction 1 -~
4 I

Merge result

Draft outward

[ Direction 2 v

[ Thin Feature v

Selected Contours ~

Jllﬁfbe

]| Boss-Extrude

v x &

From ~

Sketch Plane v

Direction 1 ~
Up To Vertex
" |

7] |

Merge result

Draft outward

[ pirection 2 v

[J Thin Feature v

Selected Contours v

Jlra$e

] Boss-Extrude

v x &

From ~

Sketch Plan

Direction 1
l

u

Merge result

Draft outward

[ Direction 2 v

[ Thin Feature v

Selected Contours ~
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— Select a
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"

Up To Vertex
Condition

Select a

- /s
|

Up To Surface
Condition
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@ Using the Offset From
Surface option:

- This option extrudes
the sketch from its plane
to a selected face, then
offsets at a specified

distance.

SE[R[&][S®

]| Boss-Extrude ¥

v x G

From ~

Sketch Plane v

Direction 1 ~
Offset From Surface
7 I

o I TE—
N —

[[] Reverse offset
[ Transiate surface
[ Merge resutt

Draft outward

Select a surface
to offset from &
enter a distance.

I

[] pirection 2 )

[ Thin Feature v

Selected Contours ~

@ Using the Up To Body option:

From Surface
Condition

- This option extrudes the sketch from its sketch plane to a specified body.

v x G

EIERAEE

]| Boss-Extrude 7

Sketch Plane v

From ~

Direction 1 ~
Up To Body .
g IR

Select a Solid Body
to extrude to
(optional).

:

e I—
Merge result
Draft outward
[ pirection 2 v
[ Thin Feature ]
Selected Contours ~
Feature Scope ~

Up To Body
Condition

- The Up To Body option can also be used in assemblies or multi-body parts.

- The Up To Body option works with either a solid body or a surface body.

- It is also useful when making extrusions in an assembly to extend a sketch to an

uneven surface.
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@ Using the Mid Plane option:
- This option extrudes the sketch from its plane equally in both directions.

- Enter the Total Depth dimension when using the Mid-Plane option.

G E[E[e][®

] Boss-Extrude El

v x & -

From ~

Sketch Plane v

Direction 1 ~
d BRI

Sl H

Merge result

'

[] Dratt outward

[J Thin Feature v

s = Mid Plane
Feature scope i Condition

- After you are done exploring all the extrude options, change the final condition
to Through All.

@ BE[R[e]S

@) Boss-Extrude ¥

v x &

From

A
Direction 1 ~
d BN

Merge result

["] Draft outward

[ Direction 2

[ Thin Feature

Selected Contours

<] €] <] <

Feature Scope

- Click OK V).

- The system extrudes the circle to the outermost surface as the result
of the Through All end condition.
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- The extra material between the first and the second extruded features
is removed automatically.

- Unless the Merge Result checkbox is cleared, all interferences will be
detected and removed.

Extrude summary:

* The Extrude Boss/Base command is used to add thickness to a sketch and to
define the characteristic of a 3D feature.

* A sketch can be extruded in both directions at the same time, from its sketch
plane.

* A sketch can also be extruded as a solid or a thin feature.
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14. Adding the model fillets by Lasso*: [~ ¢/0-m- @& 9 Lleg6-  mwwn

R
{0 Lofted cut Pattern BB Draft () Intersect Cremery Instant3D

- Fillet/Round creates a rounded internal & senevet [T - @ s @ oo

@ swept cut @] Bk dre B wee B mimer b33 g
Fillet| Linear eference Cures [ W

or external face on the part. You can G et e prl-ed-s
fillet all edges of a face, select sets
of faces, edges, or edge loops.

- The radius value stays in effect until you change it.
Therefore, you can select any number of edges or faces in the same operation.

®

- Click [Fitet| or select Insert / Features / Fillet/Round.

EIEEREEE
@ Fillet

o

@ Edge<1>

Edge<Z> A__

'
\

Edge<86> Y
Edge<57>

O
Tangent propag/fion
@) Full preview
() Partial preview

() Mo preview
Fillet Parameters ~
(K, [0125in B

[ Muttiple radius fillet

Profile:

Setback Parameters A

Fillet Options ~

- Select the Constant Size Fillet button (Arrow).

- Either "drag-select" to highlight all edges of the model or press the shortcut
key Control+A (select all).

- Enter .125 in. for radius size.
- Enable the Full Preview checkbox.

- Click OK (/).
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JD’SSOLI‘DWORKS‘ File Edit View Inset Tools Window Help Pl D-B-8B- &9 ~ @ & - Part1.SLDPRT B Searchfilesandmodels Q -/ 2 - o O X
& a o swept Boss/Base ® @ sweptcut ® EE Jdlre @ wao B Moo | 2 o
Extruded  Revalved [l Lofted Boss/Base Extruded  Hole Revolved [[J] Lofted Cut G2 PL‘";"' B Droft (D Intersect E’f""‘t" Curves In;l::BD Move/Copy
Boss/Base Boss/Base Cut  wizard  Cut atern EL L Bodies
@ Boundary Boss/Base @ sounday Cut | . - [ snen @ pome o o
Features | Sketch | Evaluate | PHg@E- -B-3-S&-0-

€& Part1 (Default<<Default>_Displa
Annotations

Solid Bodies(1)

& surface Bodies

@ Material <not specified>
(1] Front

(] Top

(1] Right

L, origin

@) Boss-Extrudel

)] Boss-Extruded

@ Fittet1

< *lsometric

>
Model [ 3D Views | Motion Study 1|
SOLIDWORKS Premium 2016 x64 Edition

Editing Part 1PS - [<]

* In the Training Files folder, in the Fillet
Built Parts folder you will also find (adds material)
copies of the parts, assemblies, and

drawings that were created for cross
referencing or reviewing purposes.

v Round
(

removes material)

* Fillets and Rounds:

Using the same Fillet command, SOLIDWORKS "knows”
whether to add material (Fillet) or remove material
(Round) to the faces adjacent to the selected edge.

15. Saving your work:
- Select File / Save As.

- Change the file type to Part file (.sldprt).

- Enter Extrude Options for the name of the file.

- Click Save. Round
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estiony for M

Dasic Jolid /"\odcling

1. To open a new sketch, first you must select a plane from the FeatureManager tree.
a. True
b. False

2. Geometric relations can be used only in the assembly environments.
a. True
b. False

3. The current status of a sketch is displayed in the lower right area of the screen as
Under defined, Fully defined, or Over defined.
a. True
b. False

4. Once a feature is extruded, its extrude direction cannot be changed.
a. True
b. False

5. A planar face can also be used as a sketch plane.
a. True
b. False

6. The Equal relation only works for Lines, not Circles or Arcs.
a. True
b. False

7. After a dimension is created, its value cannot be changed.
a. True
b. False

8. When the UP TO SURFACE option is selected, you have to choose a surface as an end-
condition to extrude up to.

a. True
b. False
. . . 3STv4 6
9. UP TO VERTEX is not a valid Extrude option. ML 3STVL
a. True 3STV49  INULS
b. False IS4 Y JNYL €

3ISTv4 ¢ aNdL’l
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Using the Search Commands:

The Search Commands lets you find and run commands

from SOLIDWORKS Search or locate commands in the user interface.

These features make it easy to find and run any SOLIDWORKS command:

- The results are filtered as you type and typically find the

command you need within a few keystrokes.

- When you run a command from the results list for a query, Search Commands

= search files and models

2

SOLIDWORKS Help

Commands

Files and Models
MySolidWorks

Knowledge Base
Community Forum
Blogs

CAD Models
Training

Youtube

Twitter

CEEB®e » a@0HE

g Manufacturers

ORRKERIRIE] «

remembers that command and places it at the top of the results list when you

type the same query again.

- Search shortcuts let you assign simple and familiar keystroke sequences to

commands you use regularly.

_JD)SSOLIDWORKS‘ File Edit View Insert Tools Window Help Ql O--B-82-5 ' & - Extrude Options.SLDPRT |B search commanas | Q[
) o swept Bosy/Base @ @ sweptcut E?t L.EE J rio & wiep B[ mimor R;Ej CU &) %
s, dos @ toneasenze | Bt Jor, negd @ toneacut T il @ ot (9 e Geamey (8950|053 | s s s
@) Boundary Boss/Base @ Bounday Cut - (@ snen @ Dome . . MySolidWarks
Knowledge Base
Ftalures‘skzlchul Evaluate | PHagPMB - B-R-Of-T- 2 o % CEINE Ty
B Blogs [
e[E[E[e]€] > & @opmen = -
N4 B Training | m
(@) Extrude Options (Default< <Default>_D G Youtube [l
+ [&) Annotations Twitter | g
» @) solid Bodies(1) o Manufacturers | @
Surface Bodies
@3 Material <not specified>
(1] Front Plane ]
(] Top Plane
[] Right Plane
L, origin
@) Exrudel
(1] Planel
(] Plane2
@) Body2
@) Btrude2
@ Fitetn %
Y
A
< >| *Isometric
Model [ 3D Views Fion Study 1 |
SOLIDWORKS Premium 2016 64 Edition Editing Part 1PS @

- Click the drop down arrow to see the search options (arrow).
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1. Search Commands in Features Mode:

- The example below shows how you might use Search Commands to find and
run the Lasso Selection command in the Feature Mode.

- With the part still open, start typing the command Lasso Selection in Search
Commands. As soon as you type the first few letters of the word Lasso, the
results list displays only those commands that include the character sequence

"lasso," and Lasso Selection appears near the top of the results list.

- Click Show Command Location

in the user interface.

Show Command Location

b o = 2P 32

i h

; a red arrow indicates the command

_ID%SOLIDWORKS‘ File Edit View Insert | Tools | Window Help Ql O-F-@B-&8-9 ' & - Extrude Options.SLDPRT 1asso Q- ?2--0 x
a o sweptBoss/Base - SOLIDWORKS Ammlcet , BE @) rib @@ wiee B mimor b b33 Sy
jcations
Extruded  Revolved s Lofted Boss/Base Extrudes Fe ;nn:ar:\ B onrt @ Intersect Zf:::;; Curves | stant30 | Move/Copy
Boss/Base Boss/Base Cut Xpress Products » Bodies
@ Boundary Boss/Base [ shet @ Dome o o
Features | Skeich | Evaluate | &y Defesture.. SHa@B-0-E-S@-0- OE - & %
° &% Euport To AEC... |
¢[ER[e[8] >
< Select £
(@ Extrude Options (Default<<Default>_D| Gy Magnified Selection g
s [l Annotations Box Selection =
+ &) Solid Bodies(1) Lasso Selection ‘ e
[ surface Bodies Iy selectan Ctrl+A
@ Material <not specified> DN invertSelection o
[] Front Plane
- [# PowerSelect..
[1] Top Plane
[] Right Plane Compare »
L. origin Find/Modify »
S
‘Tj EprEd Design Checker »
[1] Planet
Feature Paint
[ Planez v
» ] Body2 @f Format Painter..
» ) Barude2 Sketch Entities »
@ Fittetn °
Sketch Tools >
Sketch Settings >
Blocks »
Spline Tools »
Dimensions »
Relations »
@ Geometry Analysis...
¥ Equations..
e d
% Thickness Analysis...
B symmetry Check...
DimXpert »
i Macro ,
oy Evaluate »
< >| *lsometric Add-Ins...
Model [ 30 Views fion Study 1 ]
Lasso Selection A Editing Part S @
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2. Search Commands in Sketch Mode:

- The example below shows how you might use Search Commands to find and

run the Dynamic Mirror command in the Sketch Mode.

- Using the same part, open a new sketch on the side face of the model as noted.

D&SOLIDWORKS| File Edit View Insert Tools Window Help Ql O--B-&-9 ' 8} v Sketchd of Extrude Options.SLDPRT * | [ 1asso Q- ?--0 x

Exit Smart
Sketeh | Dimension

@V
0O-<-@-A
@-& T\ -

I -]

Irim  Convert
Entities  Entities

C K Mirror Entities

Offset namic Mirror Entities
Entities 1 or

BE Linear sketch Pattern

28 Move Entities =

[~ split Entities

- B3 sketch Ficture

Display/Delete
Relations

[

Quick
Snaps

o

Rapid  Modify
Sketch  Sketch

C

Repair
Sketch

Features | Sketch | Evaluate |

o
‘@ IR ]
N
#% Extrude Options (Default<<Default> D
» Annotations
b Solid Bodies(1)
[#) surface Bodies
@ Material <not specified>
[] Front Plane
[1] Top Plane
[1] Right Plane
1., origin
-
[ Sketch
[ Planet
[] Plane2
» ] Body2
» ) Extrude?
@ Fillett

[ ) Sketchd

I

G) [ ] ExtrudﬂE
B [ sketan

< >| *Isometric

RhOLE D -

0-R-o&-=-

e X

ImeET =R

Sketch face

Model [ 3D Views tion St

SOLIDWORKS Premium 2016 x64 Edition

-8.07in  5.883in_Oin _ UnderDefined  Editing Sketchd B IPS - @

- Start typing the command Dynamic Mirror in Search Commands. As soon as
you type the first few letters of the word Dynamic, the results list displays only
those commands that include the character sequence ""dyna," and Dynamic
command appears near the top of the results list.

dyna

p ‘P'm@%

Knowledge Base

Community Forum

Commands

2
>
=

Files and Models
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- Click Show Command Location | &" ; a red arrow indicates the command in the
user interface.

B ond [Ohle -/
£

w0
4

Dynamic Mirror Entities
Instant3D
Sustainability..

Show Command Location

b B - =& %

%SOLIDWORKS‘ File Edit View Insert Tools Window Help @| D-F-B-8&-9 ' G} - sketens of Extrude Options.SLDPRT dyna| Q—H ?--0X

ic Mirror Entities &
E & (S-O-N- o [ oynemic ]
Exit Smart
Sketch | Dimension
c © Dynamic Mirror Entities

990 A ul

©-© - - .

Features | Sketch | Evaluste | ] Mirrors entities dynamically about a B B B B B
G O @ o S0 centerline. - a-2

=R & [ sketem
[B Eerude cptions etauteoetaut o

Fes D [o] mirrar Entities 20 move Entities ~ le C

C
Im  Convert Display/Delete
n Offset | Dynamic Mirror Entities hntmes Repair
Entities  Entities \AEE Relations  Serl

EE inears

jed

Rapid Modify =9 Dynamic Reference Visualization (Parer

Sketch  Sketch
B9 Dynamic Reference Visulization (Child)

L Instant3D
€3 Sustainability..

21
B

5

3 Annotations

» Solid Bodies(1)
[#) surface Bodies
@ Material <not specified>
(1] Front Plane
(] Top Plane

[1] Right Plane
1., origin

@) Exdrudel

(1] Planel

(1] Plane2

@) Body2

@] Btrude?

@ Fittett

B (1 Sketcns

e eR

Lo J

T

A

< >| *Isometric
Model [ 30 Views on Study 1 ]
Mirrors entities dynamically about a centerline. 8078 6.683in_ Oin  UnderDefined | | Editing Sketchd | Bl Ps - @

- Additionally, a Search Shortcut can be assigned to any command to help find
it more quickly (see Customize Keyboard in the SOLIDWORKS Help for more
info):
1. Click Tools / Customize, and select the Keyboard tab.
2. Navigate to the command to which you want to assign a search shortcut.
3. In the Search Shortcut column for the command, type the shortcut letter
you want to use, then click OK.

- Save and close all documents.
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Exercise: Extrude Boss & Extrude Cut

NOTE: In an exercise, there will be less step-by-step instruction than those in the
lessons, which will give you a chance to apply what you have learned in the
previous lesson to build the model on your own.

rObM=

250 — r | e D50

!
3.000 }7_ J @

ox 1250 —t——f———f--- _._\
4X R.032
) B

1191 ]

Dimensions are in inches, 3 decimal places.

Use Mid-Plane end condition for the Base feature.
The part is symmetrical about the Front plane.
Use the instructions on the following pages if needed.

M= 1.750 =
Origin \,_] 000 Fe—
T
ﬁ 4X .060 X 45°
1
4000 5 (IOO

&
-— -
o
L]
o
N
.
o
. -
. -
. .
. -
- N
. \
S
.
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1. Starting with the base sketch:
- Select the Front plane and open a new sketch.

- Starting at the top left corner, using the line command, sketch the profile below.

le— 1 750 —=

Origin
—= 1000 =
/ Parallel
4000
[ 3.000
45_000 % 2.000
1.000
——1.500 —=
3.500

- Add the dimensions shown.
- Add the Parallel relation to fully define the sketch.

- Extrude Boss/Base with Mid Plane and 3.000” in depth.

T
7\
GIE[R[&]@]
D Boss-Extrudet 7
v x & 4000
From A~
|5k:tch Flane v|
45007
Direction 1 A
- -1
|M|d Plane v|
o B
& oo g
)| 2]
I:‘ Draft outward
Selected Contours w
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2. Adding the through holes:

- Select the face as
indicated and click
the Normal-To
button.

Select this face and click

- This command the Normal-To button

rotates the part
normal to the
screen.

- The hot-key for this
command is Ctrl + 8.

- Open a new sketch and draw a centerline that starts from the origin point.
- Sketch 2 circles on either side of the centerline.

- Add the diameter and location dimensions shown. Push Escape when done.

Both circles are
Symmetric about the
Centerline

- Hold the Control key and
select both circles and the
centerline, then click the
Symmetric relation on the
properties tree.
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- Create an extruded

cut using the Through- | ~ I

All condition.

BlR& &
@ Cut-Extrude1
v x 6
From ~
[ sketch Plane vl
Direction 1 -
[Through an v
[ Flip side to cut
= 2]
D Draft outward
[ Direction 2 v
Selected Contours v

3. Adding the upper cut:

- Select the upper face and click the
Sketch pencil to open a new sketch.

- Sketch a centerline

that starts at the

Origin.

- Sketch a rectangle as

shown.

- Add the dimensions and relations as indicated.

Both lines are
Symmetric about the

Centerline

- Create an extruded cut using the Up-To-Vertex

condition (up-to-surface also works).

- Select the Vertex indicated.

- Click OK.

SIBE[R[e[@]

[@ CutExtrude2 ¥

v x &

From ~

)

Direction 1

Up To Vertex

J —

G) CET—

1 Flip side to cut

[] Draft outward

Select Vertex
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4. Adding the lower cut:

- Select the lower face of the part and open
a new sketch.

- Sketch a rectangle on this face.

- Add a Collinear and an
Equal relations to the
lines and the edges
as noted.

The line is Collinear
and Equal with the
edge on both sides.

- Extrude a cut using
the Through All condition.
5. Adding fillets:
- Select the Fillet command from the Features toolbar.
- Enter .032in. for radius size.
- Select the 4 vertical edges on the inside of the 2 cuts.

- Keep all other options at their default settings.

B

@ Fillet1 Wy

[#] Tangent propagation

(@) Full preview
(O Partial preview
() No preview

Fillet Parameters ~

<
[ Multiple radius fillet
Profile:
Setback Parameters A
Fillet Options -
- Click OK.
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6. Adding chamfers:

- Click Chamfer under
the Fillet button.

[l f
EE 4 rio
Fillet | Linear

Pattern E Draft
- (@ shen
@ Filet

- Enter .060 for depth.

- Select the 4 circular
edges of the 2 holes.

- Click OK.

7. Saving your work:

- Click File / Save As.

@ E[R[e[@

@ chamfert Y
v X

Chamfer Parameters ~

@ |Face< 1> |

Face<2>

(@) Angle distance
O Distance distance
) Vertex

[ Fiip direction

& b &
[ [45.00deg =]

Select through faces
D Keep features
Tangent propagation
(@) Full preview

() Partial preview

O Mo preview

- Enter Extrudes Exel for the file name.

- Select a location to save the file.

- Click Save.
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